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This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v17.1.1 (Released 2014-10-01) 

Modeling 
Enhancements Implemented 

* Incident Description 

* 47359 An enhancement was implemented to allow modification of the model geometry based on the shape 

of a buckling or modal case mode. This can be used to simulate imperfections or other scenarios. 

Once applied, the geometry can be reset to the original. 

 67719 An enhancement was made to always use longitudinal rebar specified in the frame section 

properties for calculating capacity of hinges assigned to beams and columns even if a design is 

available. Previously if a design was available then the designed rebars were used irrespective of 

what was specified. 

 69221 An enhancement has been implemented to allow adding and importing of aluminum tee, angle, 

pipe, and tube sections. 

 72276 An enhancement has been made to the replication of local axes when point, line, area, solid and link 

objects are replicated. The following rules apply: 1. If the option to replicate local axes is set to false 

the local axes are set to default values. 2. If the option to replicate local axes is set to true then the 

local axes definitions are replicated and the following two additional changes may apply: a) if the 

local axes are defined using the advanced option which uses two joints to define an axis then the 

joint numbers are incremented if the referenced joints are replicated in the same replicate operation. 

b) if the local axes are not defined using the advanced option, the replicate option is radial, the flag 

to rotate local axes for radial replication is on and also the object reference direction is parallel to 

the axes of rotation then the angle about the object reference axis is incremented. The object 

reference axis is axial for line and link objects and the normal for area object. For point and solid 

objects the reference axes are the Global X, Y and Z directions. 

* 76109 An enhancement has been implemented to now allow mass assigned to null objects to be accounted 

for during analysis. Previously mass could be assigned to null objects but was not considered during 

analysis. Old models that had mass assigned to null objects will now have different results for any 

load cases that account for mass. 

 76130 An enhancement was implemented to add a new trapezoidal concrete frame section property. This is 

similar to the rectangular concrete shape, except that the top and bottom widths may be different. 

Concrete frame design for these sections is not currently available, as they are intended primarily 

for use in the new Concrete Solid Girder bridge deck section. 

* 76434 An enhancement has been implemented to allow specification of scale factors for the material time-

dependent properties controlling creep, shrinkage, and stiffness for concrete; and relaxation for 

tendons. For creep, shrinkage and relaxation, these factors multiply the calculated strain. For 

stiffness, the factor multiplies the modulus of elasticity at any given time. 
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Section Designer 
Enhancements Implemented 

* Incident Description 

 22355 Section Designer has been enhanced to allow prestressed tendon layouts to be drawn directly using 

the same tools used to draw rebar layout. Previously tendons could only be defined within Caltrans 

shapes. Selecting a tendon material for the drawn shape allows specification of the tendon force. 

Available shapes include point, line, rectangular, and circular layouts, as well as the reinforcing 

included as part of the rectangular, circular, and polygon concrete shapes. The tendon size, material, 

and prestress force affect the moment-curvature relationship, and hence affects Caltrans frame 

hinges defined from Section Designer sections. Fiber hinges and non-Caltrans PMM hinges are not 

affected. The PMM interaction surface used for design is not affected, but treats the tendon as 

reinforcement without prestress. 

Loading 
Enhancements Implemented 

* Incident Description 

* 53807 A new type of load pattern has been implemented called "Seastate" that will automatically apply 

accelerations due to vessel motions such as pitch, roll, yaw, heave, surge and sway based on user 

input parameters. 

* 67707 An enhancement has been made to add automated response-spectrum functions for Argentina, 

Chile, Colombia, Dominican Republic, Ecuador, Guatemala, Mexico, Peru, and Venezuela. 

* 74610 Auto seismic loading and response spectrum function for Eurocode 8-2004 have been updated for 

Norway National Annex EN 1998-1:2004 NA:2014. 

Analysis 
Enhancements Implemented 

* Incident Description 

 76508 Computation of the nonlinear behavior of link elements has been parallelized to increase the speed 

of analysis for nonlinear static, nonlinear direct-integration time-history, and nonlinear modal time-

history (FNA) load cases. This will primarily impact models having a large number of link objects 

or a large number of link elements generated to represent line or area spring supports. Analysis 

results may change slightly in sensitive or ill-conditioned models, but should otherwise not be 

affected. 

 76511 The behavior of the isotropic interacting frame hinge has been improved, particularly with respect 

to the handling of changes in bending ductility due to changes in axial load. In addition, the 

behavior when the hinge is collapsing due to a drop in the moment capacity has been improved. In 

certain rare cases, the moment-rotation results would deviate significantly from the backbone curve 

during such drops, and this has been largely resolved. Note that deviations from the backbone curve 

are expected when the axial force or M2:M3 ratio changes due to movement around the interaction 

surface. The affected hinges types are P-M2-M3, P-M2, P-M3, M2-M3, excluding fiber hinges and 

single degree-of-freedom hinges. For most models, the effect of these changes will be insignificant. 

 70912 The file-size limit for internal files used for analysis has been increased from its previous 2GB limit. 

The new limit defaults to 100GB, but this can be changed using the environment variable 

SAPFIRE_FILESIZE_MB to 1TB or more. This change will not affect most users and most models, 

since the previous limits were exceeded in very few cases. The new larger size limit applies to 

NTFS files systems only. FAT32 file systems are still limited to 2GB. Most files used for analysis 

will have the new larger capacity, although a few files may still exhibit limits for other reasons, 

such as the number of objects that can be handled. For most practical problems, the amount of disk 

space and other system resources will control the size of the model and associated analysis files that 

can be handled. 
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Frame Design 
Enhancements Implemented 

* Incident Description 

 62984 An enhancement was implemented to add the Eurocode 2 concrete frame design and Eurocode 3 

steel frame design national annexes for Ireland. 

* 73290 An enhancement has been implemented to add concrete frame design according to the ACI 318-14 

code. 

* 73295 An enhancement has been implemented to add steel frame design according to the Canadian CSA 

S16-14 code. 

* 73296 An enhancement has been implemented to add concrete frame design according to the 

Canadian CSA A23.3-14 code. 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

 67448 The graphical display of frame forces and stresses has been made more efficient. The speed increase 

may vary depending upon the component and the load case or combination being displayed. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 76207 An enhancement has been implemented to allow defining and editing of named sets for response 

spectrum and time history plots in the interactive database when the model is locked. When the 

model is locked it is not possible to delete the named sets. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 71583 Enhancements have been made to the StruCAD*3D model import, including:  (1) TITLE card 

information is now imported into the SAP2000 project information.  (2) The steel design code read 

from the OPTIONS card is now imported as AISC-ASD89 when ASD is specified in the 

StruCAD*3D model.  (3) Frame section property names are now imported as the GRUP Id 

combined with the Section Label. This allows the names to be more descriptive in identifying 

standard section shapes. 

* 76142 The import/export functionality between SAP2000 and Revit Structure has been enhanced:  (1) It is 

now possible to update a Revit project previously exported to SAP2000 or imported from SAP2000 

with changes made in SAP2000.  (2)  It is now possible to update a SAP2000 model previously 

exported to Revit Structure or imported from Revit Structure with changes made in Revit 

Structure.  (3) The import of Revit Structure wall elements has been enhanced to include walls with 

complex geometry, i.e., with more than four sides and/or with some curved sides.  (4) Curved Revit 

Structure framing elements are now imported into SAP2000 as curved frame members. 

Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 75806 An enhancement has been made to the API to let developers store application specific collections of 

strings in SAP2000 models. Three new functions have been added to the general functions: 

SetStringsExtendedEntityData(),GetKeysWithStringsExtendedEntityData(), and 

GetKeyStringsExtendedEntityData() SetStringsExtendedEntityData() lets the developer specify an 

array of string values for a given string, a “key”, and application name. The developer is encouraged 

to choose a unique application name, such as a global unique identifier (GUID), to prevent other 
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* Incident Description 

developers from accessing and modifying their data. GetKeysWithStringsExtendedEntityData() lets 

the developer retrieve the keys for which extended data exists for a given application 

name.GetKeyStringsExtendedEntityData() lets the developer retrieve a previously stored array of 

string values for a given key and application. 

 75810 An enhancement has been made to the CSi API. A new function called GetCurved_1() has been 

added to the Frame Object class. Its behavior is identical to GetCurve() but in addition to returning 

the values GetCurve(), it  also returns the curved frame object  names, if there are any. 

 75813 New functions have been added to the CSI API (Application Programing Interface) to set and 

retrieve the GUID (Globally Unique Identifier) for point-object force loads, cable-object distributed 

loads, and frame object concentrated or distributed loads. A separate GUID applies for each 

individual load assignment to an object. The GUID is now automatically created whenever any of 

these load types is assigned to an object, whether by using the API, graphical user interface, or 

database tables. In addition, GUIDs are now automatically generated for each new object when 

created. 

Documentation 
Enhancements Implemented 

* Incident Description 

 23524 An enhancement was made to the context sensitive help topic 'Reinforcement Data Form' to more 

clearly define the 'Number of Confinement Bars' input parameters. 

 70662 

76601 

77385 

An enhancement has been implemented, updating the API documentation to include Visual C++, 

Python, MATLAB, and Fortran examples.  

 73298 An enhancement has been implemented to add a listing of the default keyboard shortcuts to the 

context sensitive (F1) help. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 71219 The version number has been changed to v17.2.0 for a new minor release. 

 
 

 

 

User Interface 
Incidents Resolved 

* Incident Description 

 70047 An incident was resolved in which the menus could sometimes remain open (dropped down) after 

selecting a command, possibly obscuring other information behind them. This was a user interface 

issue only and did not affect results. 

 71091 An incident has been resolved that addressed several unreported "Abnormal Termination" errors 

that could occur when working with the graphical user interface. When these errors occurred, the 

model could be saved before the software terminated to prevent loss of data. Results were not 

affected. 

 71585 

72578 

74080 

An incident has been resolved where certain forms would not scale correctly on some versions of 

Windows when large font settings was used. 

 73104 An incident was resolved in which an abnormal termination could occur when showing the 

definition of a load combination containing other load combinations, from the design Select Design 

Combos form. 
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* Incident Description 

 73116 An incident was resolved in which an abnormal termination could occur when assigning frame 

hinges after previously using the interactive database to define frame hinges. This was a user 

interface error only and did not affect results. 

 73218 

73250 

An incident was resolved in which an abnormal condition could occur when trying to show the 

wave plot in the wave load pattern definition if some of the input parameters were invalid. 

 73308 An incident was resolved in which an abnormal condition would sometimes occur when showing 

the load case tree. This was a user interface issue only and did not affect results. 

 73601 An incident was resolved where some forms and messages did not have language translations 

available. Also some operations were slow when using translated text. This has been significantly 

improved. 

 73755 An incident was resolved in which an abnormal termination could occur when adding user-defined 

lateral bracing via the Design > Lateral Bracing command. This was a user interface issue only and 

did not affect results. 

 73814 

74671 

An incident was resolved in which an abnormal termination could occur when clicking the 'Show 

Individual Fiber Data' button on the hinge results form. This was a user interface issue only and did 

not affect results. 

 74084 An incident was resolved where it was not possible to add or modify vehicle classes in the graphical 

user interface. Vehicle classes could be added or modified using the interactive database editor. The 

automatic vehicle classes created for each individual vehicle were not affected. No results were 

affected. 

 74228 An incident was resolved in which the name of a joint constraint could be lost when modifying an 

existing joint constraint. This was a user interface issue only. 

 74229 An incident was resolved for the Frame Hinge Property Data form for interacting frame hinge 

definitions based on moment-curvature, in which the relative length option did not get saved when 

closing the form if the hinge length value was not edited. This was a user interface issue. Results 

will have matched the model. 

 74375 An incident was resolved where the program error reporting is improved. Instead of reporting "Error 

reading mesh information" the program will show the actual reason which in this case the program 

was out of memory. 

 74381 An incident was resolved in which the ability to define custom colors using the color picker was not 

available. This was previously available in v16 but inadvertently disabled in v17. 

 75204 An incident was resolved in which the program could terminate when changing the design type of a 

concrete frame section from beam to column. 

* 75504 An incident was resolved where editing joint coordinates graphically or through the interactive 

database would not immediately update the local axes of objects that used an advanced local axes 

specification that utilized a joint reference that they were themselves not connected to. Once the file 

was saved and reopened the local axes were updated. This could result in displaying the local axes 

incorrectly or even the results being incorrect if the file is not saved and reopened. 

 75782 An incident was resolved where the calculated tendon force table would not display correctly when 

right-clicking on a tendon. This was a user interface error and did not affect results. 

 76177 An incident was resolved in which the load case tree did not correctly show the relationships 

between different load cases in certain models. This was a form issue only and did not affect results. 

 76226 An incident was resolved in which the program would sometimes terminate when repeatedly adding 

copies of grid systems. This was a user interface error only and did not affect results. 

 76448 An incident was resolved where pushover plots might not display if they were based on user defined 

functions and some defined functions had been deleted.  The problem affected ATC40, FEMA356, 

FEMA440EL and FEMA440DM named pushover parameter sets. 

 76720 An incident was resolved where the Truck Loading tab of the Underground Concrete Structures 

template form could not be edited.  

 76974 An incident was resolved in which the selected item on the Assign/Define Constraints form was 

always the top item instead of the item just added to the list. This was a user interface issue that 

could result in users incorrectly assigning joint constraints. 
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* Incident Description 

 77338 An incident was resolved where entering an incorrect relative distance in the target force form could 

lead to an abnormal termination of the form. 

 77547 An incident was resolved where the Cancel button did not always work correctly when canceling 

from the User Hinge Interaction Surface definition form. Changes made on the form would remain 

even when clicking the Cancel button. 

 77579 An incident was resolved where the color coding on the design preferences and design overwrites 

forms to distinguish values between default/overwritten earlier/overwritten in this session, were 

sometimes not correct. This was a user interface issue only and did not affect results. 

Drafting 
Incidents Resolved 

* Incident Description 

 39705 An incident was resolved where the reshape tool when used at a joint of an area object would not 

work correctly and the object would end up with an illegal geometry and get deleted. 

 62778 An incident was resolved in which panning a 3-D view while in a drawing mode did not always 

work as expected. 

 70622 An incident was resolved for drawing while in DirectX mode, in which the Drawing Control Type 

options on the Properties of Object form were not working. These options worked when in Classical 

Plus graphics mode. 

Graphics 
Incidents Resolved 

* Incident Description 

 67873 An incident was resolved where the extruded shape drawn for frame objects was sometimes 

incorrectly shown when the insertion point for the frame objects was assigned to be the shear center. 

For all frame sections except the channel, the shear center is taken to be at the centroid of the 

section and the drawing has been corrected, as needed, to show this. For the channel, the correct 

location of the shear center is now shown. This was a graphical issue only and the results were 

unaffected. 

 71256 

72378 

An incident was resolved where the software could terminate abnormally when attempting to set a 

2D view using a grid system other than the Global grid system if either the Global grid system or 

the selected grid system was non-Cartesian. In certain cases the same issue could occur when both 

systems were Cartesian. No results were affected. 

 71773 

71777 

An incident was resolved where the analysis model could not be displayed in few rare cases when 

the model had not been analyzed. 

 72391 An incident was resolved in which the display of solids in 3-D would sometimes not show all of the 

faces of the solid objects when certain view settings were used. This was a display issue only and 

did not affect results. 

 73686 An incident was resolved where objects imported using the DXF import would be in a selected 

state, but the display would not show them as selected. This was a graphical display issue only. 

 73753 

74540 

An incident was resolved where certain small models would scale incorrectly on the screen. 

 74919 An incident was resolved where the node symbols would show in the wrong place in multi-step 

animation windows. This was a graphical issue only. 

 74921 An incident was resolved where the hovering over a displaced shape plot would show results for 

nodes that should have been hidden as a result of the "Show selection only" option being on. 

 77444 An incident was resolved where the principal stress arrows on solid surfaces were not showing in all 

elevation views. 
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Modeling 
Incidents Resolved 

* Incident Description 

 68423 An incident was resolved in which saved named displays were not always correctly recovered after 

saving the model. This was a display issue only and did not affect results. 

 70928 An incident was resolved in which steel axial frame hinges would have an incorrect backbone curve 

when steel frame design overwrites were assigned for the unbraced length ratio of the member. The 

hinge backbone curves used during analysis could be seen by reviewing the generated hinge 

properties. This was not an issue when the specific design overwrites were not assigned. 

 73354 An incident was resolved where springs assigned to line, area or solid elements were not included in 

staged construction analysis if lines, areas or solids were further meshed and the stage did not 

include group "All". 

 75381 An incident was resolved in which the calculator used unitless units for the Drucker-Prager friction 

angle parameter on the Nonlinear Material Data form when it should have been angle units. This did 

not affect results. 

 76044 An incident was resolved in which the Edit > Extrude > Convert Lines to Areas command resulted 

in the geometry modeled by areas not exactly matching the frame geometry. This was typically a 

minor difference equal to half of the thickness of intersecting members. 

Section Designer 
Incidents Resolved 

* Incident Description 

 70894 An incident was resolved where Section Designer would always start using the model database units 

instead of the currently selected units within SAP2000. This was a convenience issue only and did 

not affect results. 

* 71170 An incident was resolved in Section Designer where the section properties were calculated 

incorrectly if the Section Designer section (1) Contained a structural shape assigned with a concrete 

material, and (2) the Reinforcing for this shape was set to "Yes", and (3) the Rotation Angle for this 

shape was not zero. The section properties were being transformed twice for the nonzero angle in 

this case. Structural shapes without reinforcing were not affected. 

 71336 An incident was resolved where the screen refresh while drawing or editing in Section Designer was 

slow or did not show until the mouse button was released. No results were affected. 

 74740 

75324 

77606 

An incident was resolved in which Section Designer could sometimes crash when accessed multiple 

times in a row. This was due to incompatible Microsoft libraries on the client machine. The new 

version of the program no longer uses these Microsoft libraries. 

Loading 
Incidents Resolved 

* Incident Description 

* 71051 An incident was resolved in which auto-lateral wind loading was sometimes not applied to a 

diaphragm at the top of the structure because of a dimensional tolerance issue. The analysis results 

would have corresponded with the loads that were applied. 

 72987 An incident was resolved for the NTC 2008 auto-seismic loading in which the approximate period 

method was incorrectly calculating the approximate period. The period used was reported in the 

database tables, but was not correct according to the equations from the code document. The results 

were consistent with the period reported as being used. 

 75506 An incident was resolved where the option in the wind load pattern to turn off automatically 

generated wind loads on area objects would not turn the loads off if the model had been run initially 

with them being turned on and the wind load assignment to the area was not also deleted. 
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* Incident Description 

* 78267 An incident was resolved in which the open structure wind loads for circular or pipe sections was in 

certain cases using the incorrect Cf factor based on ASCE 7-02, 7-05, and 7-10 when the model 

database units were something other than feet units. When there was an error it was unconservative. 

A review of the generated loads would reveal the incorrect loading when compared to hand 

calculations. 

Analysis 
Incidents Resolved 

* Incident Description 

* 61370 

72159 

72575 

78810 

An incident was resolved where a torsional release applied to the end of a frame object with a 

section property having shear-center eccentricity (e.g., a channel section) did not result in zero 

torsion where expected, and in some cases could cause an unexpected shear force V2. When this 

occurred, the error was obvious from the torsion and shear reported in the frame object. Load 

patterns used in a mass-source specification that caused large shear in an affected member could 

also cause errors in the calculated mass if the member was short and the shear error was large. 

Otherwise, the practical effect on structural response was generally insignificant outside the 

member itself. Now when torsional and/or shear releases are specified in a frame member, shear-

torsion coupling is ignored for that member. 

* 70951 

73597 

An incident was resolved where the convergence behavior of the triple-pendulum isolator (link 

property) was poor for circumferential behavior. This could cause time-history load cases with 

independent loading in two directions to run slowly or to not converge, in which case results were 

not available. Radial behavior (along a fixed shear direction in the U2-U3 plane of the isolator) was 

not strongly affected. The overall convergence behavior of the triple-pendulum isolator has been 

made more efficient, and some small difference in results may be expected even for radial behavior. 

 71385 An incident was resolved where memory usage could grow when solving multi-step load cases 

using the Advanced solver. The effect was usually small except for structures with many 

disconnected parts. No results were affected. 

 71398 

73971 

An incident was resolved where modal time-history load cases could fail to run when the 

prerequisite modal case was analyzed in a previous run rather than in the same run as the time-

history case. When this occurred the results were unavailable for the time-history load case. 

* 71962 An incident was resolved where the results for the triple-pendulum isolator could be incorrect when 

recovered after running a nonlinear load case. The results of a nonlinear load case starting from zero 

initial conditions were not affected except for the triple pendulum isolators themselves: the results 

for the joints and all other elements were correct. However, the results for any nonlinear case 

continuing from a previous nonlinear case could be affected by the incorrect results for the triple 

pendulum isolators from the previous nonlinear case. 

 73432 An incident has been resolved where the shear factors "factV2" and "factV3" in the formulas used to 

calculate shear stresses S12 and S13 for the circular frame section at the points 2, 3, 6 and 7 (angles 

315, 225, 45 and 135 degrees, respectively) should have been R^2 / 6 instead of R^2 / (3*sqrt(2)). 

The computed results agreed with the formulas as documented in the technical note "Frame Stress 

Calculation". In addition, the shear factors "factV2" and "factV3" in the formulas for S12 and S13 

for the pipe frame section at the same location have been enhanced to use an exact analytical 

solution without the thin-walled assumption. Only analysis results are affected by these changes. 

Design results are not affected. 

 73916 An incident was resolved where certain models containing wave loads could generate an abnormal 

termination error message when trying to run the analysis. When this occurred, no results were 

available. This issue affected versions 17.0.0 to v17.1.1.  

 74253 An incident was resolved in which an abnormal termination could occur when running the analysis 

of certain models containing auto seismic lateral loading. 

 76847 An incident was resolved in which the program could terminate when attempting to analyze a model 

containing area objects with more than 4 points and the program was run from a location without 

administrator permissions. 
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Frame Design 
Incidents Resolved 

* Incident Description 

 54893 An incident was resolved where the program allowed the same load combination to be selected for 

both strength and serviceability for frame design. This would cause the form to not maintain the 

data when the form was exited. A load combination can only be selected for either strength or 

serviceability. 

* 67904 

71495 

72052 

72674 

73105 

76255 

77221 

An incident has been resolved for steel frame design in which the program was failing to optimize 

for (a) group constraints, (b) lateral displacement targets, and (c) time period targets. The program 

no longer terminates when a time period target or a displacement target is deleted. The program was 

only optimizing for strength and was selecting one optimum member correctly for individual 

member design optimization. All steel frame design codes are affected. The results were obvious as 

all members of the group were not being assigned the same section, and the displacement and time 

period targets were not being met. The problem was introduced in v17.0.0. 

 69927 

71242 

72985 

An incident was resolved where the frame design on large models was taking too much time. This 

was simply a graphics issue of blinking the member that was being designed and did not affect any 

design results. 

 70446 An incident was resolved in which an error was generated when using the Design > Concrete Frame 

Design > Verify All Members Passed command. This did not affect the design results. 

 71163 An incident was resolved for frame design where attempting to right-click on a frame member while 

viewing design results saved from a previous SAP2000 session would cause an abnormal 

termination error. No results were affected or lost. Running the design, even for a single member, in 

the same session would prevent this problem. Only version 17.1.1 was affected. 

 71350 An incident was resolved in which the auto generated ASD load combinations for AISC 360-10 

steel frame design incorrectly used a scale factor of 0.75 for the combination of dead + live + wind 

load. The factor on the wind is permitted to be 0.75*0.6 per ASCE 7-10. 

 71446 An incident was resolved for steel frame design using the Eurocode 3-2005 and NTC 2008 codes in 

which sections with 3mm thick elements were being reported as being too slender to design, while 

the design code permits 3mm thick elements to be designed. This limitation was conservative. 

 71698 

72996 

An incident was resolved where the unbraced length, when over several members, may not have 

been traced correctly for frame design when the display was in a coordinate system other than the 

default Global system. The incorrect calculated unbraced length was reported. 

 73415 An incident was resolved for steel frame design where all the design results could become null after 

displaying the design tables. Using the mouse right-button click on a member after displaying the 

design tables would show all results as zeros as if there was no load on the member. Saving and re-

opening the model, or unlocking and re-running the analysis and design, would resolve the issue. 

The actual design results, when not shown as zeroes, were correct. 

 74835 An incident has been resolved for steel frame design according to AISC 360-10 in which the error 

message about compact or non-compact sections for seismic moderately and highly ductile frames 

was not correct. It affects the error message only. All calculations are correct. Only the AISC 360-

10 code was affected. 

 74880 

74955 

75876 

78314 

An incident has been resolved in the program in which the K factor calculation was not correct for 

members which had restraints. This resulted in larger K factor values for sway conditions which 

eventually resulted in small capacities and large PMM ratios. The results are affected 

conservatively. The error was introduced in v17.0.0. 

 74894 An incident was resolved for Eurocode 2-2004 concrete frame design where the concrete modulus 

of elasticity was incorrectly computed. The computed value was shown in the design output. The 

difference in computed values of modulus of elasticity of SAP2000 and EC2 Table 3.1 was 

insignificant for all practical purposes. There is no effect in design. 

 76385 An incident has been resolved in which the automatic load combinations were not generated 

according to the Chinese 2010 steel frame design for the limit state of deflection. 

 76386 An incident has been resolved in which the software would terminate during concrete frame design 

using the "Chinese 2010" design code. This was a problem only when there were two automatic 

seismic loads defined. 
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* Incident Description 

 76395 An incident was resolved for the Chinese 2010, GB 50010-2010 concrete frame design in which the 

G_RE(PMM) value was always reported as 0.80 instead of varying based on the axial force ratio in 

which it should have been 0.75 when the P ratio was less than 0.15. For most cases there would 

either be no effect on the results or they would be conservative. For cases with high axial load the 

results will be unconservative by a maximum of 7%. 

 76396 An incident was resolved for concrete frame design per the Chinese GB 50010-2010 code in which 

two problems have been fixed: (1) The effective length instead of the unbraced length was used in 

the expression of moment amplification factor eta. Now the expression uses the unbraced length. (2) 

The program now enforces Cm*eta to be at least equal to 1. If the product is less than one, the 

program uses the original factored moment as the design moment. No amplification is done.   

 77553 An incident has been resolved in cold-formed steel frame design code AISI-LRFD96 in which the 

value of the phi factor for major direction shear was reported as zero in the design details. In 

addition, the Vn ratios for major and minor direction shear forces were not reported appropriately 

with decimal or scientific format dynamically based on how small they were. Both problems have 

been fixed. This does not affect the design results. This was a reporting problem only. 

 78805 An incident was resolved where the "Make Auto Select Section Null" operation for frame design 

would not use the last design section for the next analysis. It required the analysis to be rerun after 

the design before this operation was performed. 

 78864 An incident was resolved for steel frame design according Norsok N-004 and API RP-2A in which 

design results were not calculated when wave loads were considered and the 'Pressure Equalized' 

design overwrite was set to 'No'. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 62979 

72926 

An incident was resolved in which the graphical display of the joint punching check ratios did not 

display results for all joints.  

 67470 An incident was resolved where non-fiber hinges with load carrying capacity after point E specified 

to be extrapolated (rather than dropping load) would report the hinge state as 'D to <=E' even for 

hinge deformations beyond point E. Now the hinge state will be reported as '> E' in the extrapolated 

region. Also resolved was an error where the stiffness of the extrapolated region of the force-

deformation curve was taken to be a very small but finite stiffness instead of using the stiffness of 

the curve between points D and E as documented. This latter issue only affected non-isotropic, non-

fiber hinges. 

 71084 An incident was resolved in which the File > Print Graphics output always indicated the units as the 

database units even when the display units had been changed. The displayed output and contour bar 

(if present) was correct, but the units were incorrect if the current display units were different than 

the database units. 

 71151 

73283 

An incident has been resolved for all steel frame design codes where the failures related to seismic 

provisions for steel frame design were not properly identified through color codes when displayed 

in the model window. Design details provided by right-button click on a member and most results 

presented in the tables were not affected, only the displayed color code and the error message 

shown in the "Steel Design 1 - Summary Data" database table. This error was introduced in v17.0.0. 

 71250 An incident was resolved where concrete frame design results were not fully available after 

reopening a model in a new SAP2000 session. Design results could be displayed graphically on the 

model window, but attempting to right-click on a member for detailed results would produce an 

abnormal termination error. Similarly, tabular results were not available in this situation. Running 

the design, even for a single member, after reopening the model would enable the display and 

output of the correct design results for all members. Result values were not affected by this error, 

which affected only version 17.0.0 to v17.1.1. 
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* Incident Description 

 71692 

72314 

73542 

74135 

An incident was resolved in which the File > Print Graphics command did not show symbols 

representing joints when these symbols were turned on in the set display options. 

 71795 An incident was resolved in which saved named displays did not show text, such as object labels, 

when included in a report. 

 73378 An incident was resolved where the hinge status (LS, IO, CP) shown in the table “Frame Hinge 

States” could be incorrect for load combinations and for load cases when enveloping results were 

requested. This could also affect the plotted hinge status for enveloped results. The hinge status was 

correct for individual steps of a load case. The hinge state (A, B, C, D, E) was not affected. 

 73600 An incident was resolved where the frame stress plots (command Display > Show 

Frame/Cable/Tendon Force Diagrams) could be incorrect when consecutive frame objects were 

assigned a nonprismatic frame section property with the advanced setting, i.e., the length of the 

frame object was less than the full length of the nonprismatic section variation. This could also 

affect the stresses reported in the table "Element Stresses - Frames". This did not affect frame 

objects that contained the entire length of the nonprismatic variation (the most common case), even 

though the object could be meshed into multiple frame elements for analysis. No other results were 

affected (such as frame forces and moments, displacements, and reactions). 

 73855 An incident was resolved in which the File > Print Graphics command did not display the plane ID 

when printing a planar view. 

 74938 

75224 

An incident was resolved where the font size was too large for certain text items when printing an 

isometric view using the File > Print Graphics command. Printing of perspective views was not 

affected. 

 75099 An incident was resolved for the generated reports in which the license number was not being 

populated on the cover page and the header of the report pages. 

 75321 An incident was resolved where attempting to display results onscreen for a model with plane 

elements that had area springs would result in a runtime error if the link elements created by these 

springs were set to show. This was only a display problem and results were unaffected. 

 76383 An incident was resolved for the Chinese 2010 steel frame design code where the Effective Length 

Factor and Length Factor were switched in the design details report. This was a display issue only 

and no design results were affected. 

 78940 An incident was resolved where the values shown on the model for frame member forces when 

hovering over the frame member may not have been correct. This happened when the member 

forces shown were double valued or were for a combination. Frame member forces shown when the 

member was right clicked, or in tables or used for design were not affected. 

Database Tables 
Incidents Resolved 

* Incident Description 

 71345 An incident was resolved where the database did not correctly import cable shape data when the 

cable type was "Relative undeformed length". 

 72056 

73932 

An error was corrected where export to Excel did not work if the computer had regional settings 

that used a comma for the decimal point. This affected versions 17.0.0 to v17.1.1. 

 74496 An incident was resolved in which importing a model from Excel would fail if any of the Excel 

sheets were protected. 

* 74549 

76561 

An incident was resolved where the section cut forces reported in the database table "Section Cut 

Forces - Design" may have been reported incorrectly for some section cuts if the following two 

conditions occurred: (1) Results were displayed for more than one load case at the same time, and 

(2) The load cases requested contained response spectrum cases. If both of these conditions 

occurred the response spectrum case results could be from one of the other selected load cases. 
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* Incident Description 

 76147 An incident was resolved where exporting database files (Text, Excel, Access) was quite slow when 

an alternate language file, CSiLanguageResource.xml, was present in the installation folder. This 

also made saving the model file slow, since the *.$2k text file is written as a database file. No 

results were affected in any case. 

 76380 An incident was resolved where the monitored joint id was not imported correctly for a nonlinear 

static pushover case. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 71613 An incident was resolved which affected the import of CIS/2 files. When the name of a CIS/2 file to 

import had several extensions, i.e., it contained more than one period, the file was not imported. 

 72570 An incident was resolved in which certain Nastran *.dat files were unable to be imported in v17. 

 73446 An incident was resolved for the import of SACS models in which the imported material property 

modulus of elasticity and shear modulus were off by a factor of 1000. The analysis results agreed 

with the model as imported. 

 74148 An incident was resolved for the import of SDNF files where non-default frame local axes were 

being imported but not always applied to the model. When this occurred, the default local axes were 

being used instead. Exporting the model to SAP2000 text file (.$2K or .S2K) and re-importing it 

would correct the problem. This affected all previous versions of SAP2000 that could import SDNF 

files. 

 74507 An incident was resolved that improves the import of STAAD files with STAAD floor loads and 

one-way loads. Previously STAAD floor loads and one-way loads were imported as frame 

distributed loads assigned directly to the frame members located within the corresponding area, with 

the result that the load distribution did not necessarily match the STAAD frame distributed loads. 

Now these STAAD loads are imported as SAP2000 shell uniform-to-frame type loads that are 

assigned to shells imported from STAAD if they exist at matching locations, or assigned to shells 

with "None" properties created for the purpose of distributing these loads. SAP2000 results may still 

not match STAAD results exactly in all cases, as the algorithms for distributing loads may differ 

between the two products both in the horizontal plane and over an elevation range. In most well-

defined cases, however, the agreement should be close. Previously and now, SAP2000 results agree 

with the model as imported. 

 75231 An incident was resolved where the SAP2000 model could not be exported to Perform3D. This was 

a problem with v17.1.1 only.  

 76175 An incident was resolved where nonuniform loads on shells were not correctly imported from 

STAAD models. In most cases results were unavailable for load cases where these loads were 

present. These models should be imported again. 

 76883 An incident was resolved for the SACS import of prismatic sections in which the imported S22 and 

Z22 values were not correct. Results were consistent with the values of these properties as reported 

for the imported frame sections. 

Data Files 
Incidents Resolved 

* Incident Description 

 71979 An incident was resolved in which the active degrees of freedom settings were not imported from 

text (*.s2k, *.$2k), Excel, or Access files. After import the analysis results matched the model, 

which would have all degrees of freedom active. This error was introduced in v17.0.0. 

 73128 An incident was resolved in which developed elevations were not correctly recovered after saving 

and reopening a model. 

* 73159 An incident was resolved where old models were unable to be opened when the regional settings on 

the computer were set to “Turkey”. 
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* Incident Description 

 74589 An incident was resolved in which an imported model would generate errors if the computer region 

settings used a comma (,) for the decimal separator. 

 76286 An incident was resolved where the program was not correctly importing the Overwrites - Auto 

Wind Loads - Frame table and the Auto Seismic - IBC2012 table. 

 76845 An incident was resolved where in some rare cases the import of certain section designer sections 

could fail. 

 77888 An incident was resolved where an abnormal termination error occurred when reading a response-

spectrum function from a file if the data was specified as frequency-value pairs and the first 

frequency value specified was zero. When converted to period, this resulted in division by zero. 

Now when a zero-frequency value is specified, an intermediate data point is interpolated as the 

average of the first two data points and used instead of the zero-frequency point. Functions specified 

as period-value pairs were not affected and have not been changed. 

Documentation 
Incidents Resolved 

* Incident Description 

 71731 The API documentation has been updated to include instructions in the documented API examples 

for attaching to running instances of SAP2000. 

 72615 An incident was resolved in which the AISC 360-05, AISC 360-10, and CSA S16-01 steel frame 

design manuals referred to the design preference 'Maximum Number of Auto Iteration' which does 

not exist in SAP2000. 

 74504 An incident was resolved in which the context sensitive help topic 'Welcome to SAP' referred to the 

Basic Analysis Reference manual which no longer exists. This was a documentation error only. 

Application Programming Interface 
Incidents Resolved 

* Incident Description 

 69472 An incident was resolved correcting two API function issues. (1) An issue in the API function 

SapModel.Analyze.GetCaseStatus prevented some COM clients from being able to successfully 

retrieve data.  (2) An issue in the API function SapObject.Hide caused an error to be triggered in 

some COM clients. 

 73478 An incident was resolved where the SAP2000 OAPI command SapModel.File.OpenFile could not 

open *.$2k files. 

 


